GCC..

SignPal Instruction

The SignPal Software is Windows System compatible and all versions support the AAS Il contour
cutting function.

SignPal Instruction Index:

[1] Installing the SignPal software

[2] Set up your GCC Cutter on Production Manager
[3] SignPal AAS 1l Quick Start

[4] How to set Die Cut

[5] How to set Creasing (RXIl model only)

[6] SignPal Features List

[1] Installing the SignPal software
To install the software, you must have Administrator privileges. To use the software, you must have
Administrator or Power User privileges. See your Windows user guide for more information.

1. Uninstall any previous version of the software.

2. Visit GCC website (https://www.gccworld.com/download.php?act=view&id=20) to download
the WinRAR file.

x‘ Company Applications Products Technology Support Contact Link @ en Q
=

Tech Support

Download Area

Product Termination Policy

Out of Warranty Service

AFR-24S

Digital Cutting and Creasing
with Auto Sheetfed Solution

Download Area v

Download Area

enter keywords to search Q SEARCH
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Or browse by machine model

Vinyl Cutter Laser Engraver Laser Cutter

Download Area v

| Vinyl Cutter vinylCutter v

= z
| & iﬁé‘(’ﬁ?
%/;
Expertll A i-Craft™ 2.0 AR-24 Expert Il

Puma v Jaguar V [ Jaguar V (PPF) RX I / RX Il (Creasing)
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Title Size Download
SignPal V19 817 MB Download
GreatCut 4 for Windows (V417.O.20.21868) 294MB Download

3. Follow the installation and activation instruction for SignPal below.

1 Install and activate software on an online computer

1. Launch your browser and type https://www.saicloud.com in address bar and press enter, then
input your activation code, then click Activate, activation code can be found in the code label
in software package.

Activation Code

Pleaze enter the activation code that accompanied your software purchase

Activation Code SH4LA)

2. Inlogin section, click | am new to the SAi Cloud and input your email address, then click

Create A Free SAi Cloud Account

 lam a returning customer

1 am new to the SAi Cloud

Enter your email address to get started.

Important: The email address you select for
this SAi Cloud account will be the owner of
the software. It will be used for all SA
software services. Itis recommended you
use a permanent business email address.

724306662@0qq.com
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Create Account, an email will be sent to your mailbox.
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3. Check your mailbox and click website link in the email then complete the information
fields.

Create Account

PazraTT T e e’ & omrmTes

e )
ra Terms And Conditions
s Terms and Conditions t
User Agreement
=1, 1} RN SrCC u IMPORTANT—READ CAREFULLY:
This Account User's Agreement is a legal contract between You (defined below)
STmeZow | oaTTimnon UTe [} and
L SA International Inc

BY USING YOUR SAi CLOUD ACCOUNT, YOU (AS THIS TERM IS DEFINED
[ )BELOW) AGREE BY CLICKING ON THE “ACCEPT” BUTTON TO BE BOUND
Pt Lemd BY THE TERMS OF THIS AGREEMENT (AS THIS TERM IS DEFINED BELOW) ,
INGLUDING, BUT NOT LIMITED TO, ANY WARRANTY DISCLAIMERS,
LIMITATIONS OF LIABILITY, JURISDICTION, AND TERMINATION

Oy
PROVISIONS. IF YOU DO NOT AGREE TO THE TERMS OF THIS
AGREEMENT, DO NOT OPEN AN SAi CLOUD ACCOUNT AND EXIT NOW
Sl Pravinos
Article |. Defined Terms:
IpTorwm 1. Account means your account on the SAi Cloud

2. Agreement means this End-User Account Agreement.
3. Entity means any individual. parinership. joint venture. corporation. limited x

| I 1 Accept the Terms and Conditions m

!

Step 2. Add Software to your SAi Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAi Cloud Account.

| Activate Now |

SignPal Instruction
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4. Open Autorun in the WinRAR file. Then install software step by step by following the
wizard.

Select the language for the nstalaton flom
the choicas halow.

=)

Chinese [Simpified]
Chineze [Tradiional]
Dutch

SAi Production Suite Cloud g SAi Production Suite Cloud [

A 4 Setup Status PRODUCTION

‘Welcome to the InstallShield Wizard for SAi
Production Suite Cloud SUITE

54 Praduction Suite Cloud is cofiguring your new software installation

The Installhield? Wizard wil install SAi Production Suite N B = = =
Cloud on your computer. To continue, click Nest SAi Production Suite - InstaliShield Wizard ﬂ

. K the USB dongle is connected to the computer, please remove it now,
B cothatthe dongle driver can be installed

Back Cancel {\ Cancel

- 3
S Production Suite Cloud A4 B [ sai production Suite Cloud = =5

PRODUCTION
SUITE

Select Features PRODUCTION Setup Status

Select the features setup will install

54 Production Suite Cloud is configuring your new software installation,

Desciption

Safelet Sentinel diver
Iristalling

D\ ASAivSA) Production Suite Cloud\Frogram\aGrepDev. dl

704.70 ME of space required on the D diive
30838.40 ME of space available on the D dive

[ <Back || Memr | [ Cancel |

E I &

o
SAi Production Suite Cloud ﬂﬂ 4 EESE " production Suite Cloud y‘ ==

e A Do s et PRODUCTION Choose Destination Location PRODUCTION
SUITE Select folder where setup wil nstal i SUITE

Please read the following license agreem

S viarE [cehed AsEEst = Setup will install 54 Production Suite Cloud in the following folder.

T T e e | ;nmum;a\’\ Dnag:\s folder, click Nest. To install to a differsnt folder, lick Brawss and sslsct
contract between You (ss defined below] and 54 Intemational Inc. for the Flesi and :

PhataPRINT Software (as defined belaw],

This Agreement (a5 defined below] sets forth the terms and condtions for liensing of
the Software from 54 Intematianal Inc. and ‘fou (as defined belaw), and instaling and
using the Software. This Agreement applies to any (1) single-user license; (i) muliuser
license: and (il original equipment manufacturer [DEM) or Special Edtion [SE] versions of
the Software and other branded or customized wersions unless otherwise agieed.

BY OPENING THE SEALED PACKAGE CONTAINING THE SOFTWARE OR V
DOWNLOADING THE SOFTWARE FROM AN AUTHORIZED DN-LINE SITE, OR =

Destination Falder

[l Db ASAMNSAL Production Suite Cloud Browse.. |

| accept the tems of the license agresment |

T'donat accept the terms of the icense agieement

[ <Bask [ mew> || [ concel <Back
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5. Paste your code into activation codefield.

s
Activation Code m  — 0 — —
Enter an Activation Code to get a license License
K Success

o

When you purchase new software it comes with an Activation Code. Erterthe
Activation Code below

Licensing Successful
Activation Code: | SHALALNCZHTTW3TYZDU| |

6. Select language you need, click OK and finish installation.
- Not Tor resale:

Product: iF‘hob::PF‘.INT SERVER-PRO Cloud

Language: iEninsh

1 [ Clear Application's previous preferences
I~ Install to startup items

SignPal Instruction
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2 Install and activate software on an offline computer

1. Open Autorun in the WinRAR file. Then install software step by step by following the

wizard.

SAi Production Suite Cloud

Select the language for the installation from
the choices balow.

Ehinese [Smplfied]
gﬁzzse [Traditional]

)

SAi Production Suite Cloud

‘Welcome to the InstallShield Wizard for SAi
Production Suite Cloud

The InstallShigld? \wizard will install S4i Production Suite
Cloud on your computer. To continue, click Next

pack [

Setup Status

S4i Production Sute Cloud is configuring your new software installation

-
SAi Production Suite - InstallShield Wizard

Tf the USE dongle is connected to the computer, please remove it now,
284 sothat the dongle driver can be installed

Cancel

(S

PRODUCTION
_SUITE

SAi Production Suite Cloud

cxal

Please read the follawing license agres

License Agreement

Softwars Licenss Arssment

IMPORTANT(READ CAREFULLY: T his Agiesment [as defined below) is 5 legal
contract between You (ss defined below] and 54 Intemational Inc. for the Flesi and
PhataPRINT Software (as defined belaw],

This Agreement (a5 defined below] sets forth the terms and condtions for liensing of
the Software from 54 Intematianal Inc. and ‘fou (as defined belaw), and instaling and
using the Software. This Agreement applies to any (1) single-user license; (i) muliuser
license: and (il original equipment manufacturer [DEM) or Special Edtion [SE] versions of
the Software and other branded or customized wersions unless otherwise agieed.

BY OPENING THE SEALED PACKAGE CONTAINING THE SOFTWARE OR
DOWNLOADING THE SOFTWARE FROM AN AUTHORIZED DN-LINE SITE, OR =

(@ | accept the tems of the license agrsement |

" Tdonot accept the ferms of the icense agieement

[ cBack [ Newr J[ Coancel |

-
SAi Praduction Suite Cloud

Setup Status

541 Production Suite Cloud is configuring your new software installation.

Irstaling

DA ASARS A Production Suite Cloud\ProgramtéGreyDev.dil

PRODUCTION
SUITE

Cancel

et

SAi Production Suite C\uud'u‘

SAi Production Suite Cloud

e

Choose Destination Location
Select folder where satup will install files,

PRODUCTION

Setup wil install 341 Production Suite Cloud in the following folder.

Toinstall t this folder, click Nest Toinstall to 5 differsnt folder, click Brawese and salect
another folder

Destination Falder

D:h . A5ARSAL Production Suite Cloud

| Browse.. |

Select Features
Select the features setup will install

Select the features pou want to install, and deselect the features pou do not want to install,

Description

4i Production Suite Cloud

lamples SafeNet Sentinel driver

704.70 MB of space required on the D diive
30838.40 ME of space avaiable on the D dive

PRODUCTION
SUITE

<Back || New» ||

Cancel

SignPal Instruction
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2. Record your computer ID in the dialog box below and look up your computer name, You can
find your computer name by right-click on My Computer and choose Properties.

© - 5

License
Could net communicate with the: SAi Cloud

| Licanse manager was unabls to connect to the Cloud Licenss Server. Possible |
causss for this may include

- The "SAi Cloud" website may be expenencing issues. Flease open your
| browser and try to log into your account on www saicloud.com

- Your activation code has not yet been linked to your saicloud .com account.
Please go to www saicloud com, enter your activation code on the
"Activation Code" field, enter your email address and password, and click on

"Activate License.” Syt
Em
- Your computer may not have access to the license server. Please verfy that 4

port 443 is open for beth incoming and outgoing connections in your firewall for , - ) p
all 54 applications. Rating: ﬂ Windows Experience Index
During the process you may be asked for a Computer ID. If you require & Processor: Intel(R) Core(TM) i5-2450M CPU @ 2.5(
Computer 1D, use the value below
Installed memony (RAM): 8,00 GB (7.90 GB usable)

hitps://www saicloud.com/
| Computer |D: 5E19DA26B331 I System type: 64-bit Operating System

You should retrieve = licens file from the website. When you have a license file B Tohe No Pen or Touch Input is available for t
imort # using the button below

Computer name, demain, and workgroup settings
= Import License File

Computer name: Jeff-PC
= Use Proxy Settings I I Full computer name: Jeff-PC I
! | Computer description:
! Back e [T‘ Workgroup: WORKGROUP

3. Launch your browser on another online computer and type
https://www.saicloud.com in the address bar and press enter, then input your
activation code and click Activate.

The Activation code can be found in the software package certificate.

Activation Code

Please enter the activation code that accompanied your software purchase

Activation Code SH4LA

SignPal Instruction
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4.1n login section, click  am new to the SAi Cloud and input your email address, then
click Create Account, an email will be sent to your mailbox.

Create A Free SAI Cloud Account

) | am a returning customer

1 am new to the SAi Cloud

Enter your email address to get started.

Important: The email address you select for
this SAi Cloud account will be the owner of
the software. It will be used for all SAi
software semrvices. It is recommended you
use a permanent business email address.

¥84306662@0g.com

Create Account

5. Check your mailbox and click website link in the email then complete the information
fields.

Step 2. Add Software to your SAi Cloud Account

Add To SAi Cloud Account

This software license will be added to your SAI Cloud Account.

Activate Now

SignPal Instruction
10
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6. Click “License Manager” can’t connect and input your computer ID and computer name

that you recorded for the offline computer before, then click Create license Now and
Download License, save license file tolocal.

Step 1 - Download

Clicking on the download button below will download a small application. Run the application to do

Download Mow

Step 2 - Install

Once the download is complete, run the installer. The final step in the install process will run a "Lic
application.

Step 3 - License
The "License Manager” application will ask for an activation code. Use the activation code below tc
QTPSNDBSFXYUXGXHLTAG

"License Manager” can't connect? I

Ul

Create License Current Install

o0 Back Computer ID: 5E19DA26B331
Your software will be licensed to be used on the computer wit
Computer Name: JEFF-PC

|:> User Name: Administrator

Mar 21, 2014

Computer D

Computer Name

Download License

License Remaved?
Create License Now

Download Now

SignPal Instruction
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7. Copy license file to offline computer via a removable disk device, then import it.

= -

License
Could not communicate with the SAi Cloud

License manager was unable to connect to the Cloud License Server. Possible
causes for this may include:

- The "SAi Cloud" website may be experiencing issues. Please open your
browser and try to log into your account on www.saicloud com

- Your activation code has ot yet been linked to your saicloud.com accourt

Please go to www saicloud.com, enter your activation code on the 0 open
“Activation Code” field, enter your email address and password, and click on
"Activate License " @.\"_. wl L » Computer » LocalDak (D) » Users » o1 )
- Your computer may not have access to the license server. Please verify that P— Mo foindet ™
port 443 is open for both incoming and outgoing connections in your firewall for i -t
all SAi applications = Mame
S Lbranes
During the process you may be asked for a Computer [D. I you require a % Admunmtemes
Computer ID, use the value below. o S
¥ Decurments,
Fitps//www saicloud.com/ | e
Computer ID: S5E13DA26B331 ) P
You should retrieve a license file from the website. When you have a license fils ) B Videor
imart it using the button below
& Computer
B Local Drid dC
o Local Dk (B5j
s New Volume [E:}-
. 5 OO Drve (13 CRE
2 Use Proxy Settings sl
File e licerue-00772250n = {License Fie " isn} =
<Back  |[ Next> Close Opan__ Cancel
= — — il
o == o . - - .- |
License @) License @)
License successfully imported. ' Software ID: 0077325
License Type: TRIAL
Expire Date: 20042014
Licensed On:  This Computar
Computer 1D: 5E19DA26B331

Click Mext to continue

LR :
2 Check For License Updates
==
= Import A License File

 Remove License From This Computer

< Back Next >

Close

8. Select language you need, then click OK and finish installation.

- Mot for resale

Product: |PhotoPRINT SERVER-PRO Cloud

]

Language: |English

i

¥ Install to desktop:
I Clear Application's previous preferences
[ Install to startup items

%

3 Transfer license on an online computer

SignPal Instruction
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1.0pen License Manager from Start menu.

SAi Production Suite Cloud
@ Install Manager
ﬁ lob Monitor

|y':—"'.'] Preference Manager

License Manager
sl PhotoPRINT EDITOR-PRO Cloud

ﬁ PhotoPRINT SERVER-PRC Cloud

2.Click Remove License From This computer, Now you can install the software on another

computer.

3

o i

o "

- ®

Software ID: 0077325

license Typs:  TRIAL
Expire Date: 20042014

licensed On:  This Computer

Computer ID:  5E19DA268331

= Check For License Updates

< Import A License File

=» Remove License From This Computerl

Back || Finish Close.
—

]
- ®

The license was successfully removed from this computer

Software 1D 0077325
Removal Code:  NLSK7RKC3IR

+ License this computer again

Close

SignPal

Instruction
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4 Transfer license on an offline computer

1.0pen License Manager from Startmenu.

SAi Production Suite Cloud
{'& Install Manager
% lob Monitor

I €3 License Manager I
i7sl PhotoPRINT EDITOR-PRO Cloud
@ PhotoPRIMNT SERVER-PRO Cloud

|r:—’:'J Preference Manager

2.Click Remove License From This computer, then record removal code in license dialog box.
© = o 5 =)

License @) Licsnse @)

Software ID: 0077325
License Type TRIAL

Expire Date 20-04-2014
Licensed On. This Computer
Computer ID: BE15DA26B331

The license was successfully removed from this computer.

Software ID: 0077325

Removal Code: | GMYKCTIG4S

= Check For License Updates N

; . ¥ & License this computer again
= Import A License File

= Remove License From This CumputE(l

Finish Close Back Close

3.Launch your browser on another online computer, access https://www.saicloud.com and

login with your account. Click License Removed then input removal code and click Remove.
After this you can install software on another computer.

@) Cloud
Current Install

Computer ID: 5E19DA26B331
. Software Removed?
Computer Mame: jeff-pc

User Mame: Jeff When a software license is removed from your computer, it will attempt to
over the Internet. If your computer was unable to communicate over the Int
have displayed a removal code. Enter the removal code below

Mar 21, 2014 — Pley

Removal Code

GM|

Download License

z R
|L|ce|1se Re*"c‘-;ed?l

No Removal Code?

Download MNow
Go Back

SignPal Instruction 14
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[2] Set up your GCC Cutter on Production Manager

1. Open Production Manager 12
2. Choose and set up your GCC cutter.
(Note that AAS Il System only works on RX II, Jaguar V LX, Puma lll, Expert Il LX models.)

-%I

Choose a device

What is the brand name of your vinyl cutter?

[acc -]
What is the model name of your GCC?

|an2s )
GRC-23 [E
HCraft 3=
Jaguar 111101
Jaguar I1-132
Jaguar 111-183
Jaguar |1I-61
Jaguar II-76
Jaguar IV-101
Jaguar 1V-132
Jaguar IV-183
Jaguar 1V-61
Jaguar IV-76
Jaguar JIIF1015
Jaguar JII-1325
Jaguar JIi-61
Jaguar JII-765
Jaguar JR-1015
Jaguar JR-1325
Jaguar JR-61
Jaguar JR-765

- Jaguar V-101 L
Jaguar V-101 LX

Jaguar V-132 :] m
Jaguar V-132 LX -

e Jaguar V183

==

What do you want to call your new setup?

Jaguar V61 Lx

How is your Jaguar ¥-61 LX connected to your computer?

GCC LISB 000 \ v][ Browse...

[ Back I Finish [ Cancel

[
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T ——rr

|| File Edit Setup View Help
—

GCC Jaguar V-61 LX@GCC USB 000 Job Narme Status Tools
‘%" Jaguar V-61 LX

Files Flexiquote Reports

m

Resources

- @ &

Printer Support License L 4
Profiles

=

Youtube Facebook

More
© 2012-2016 SA International. Inc.

L T b

= VM Free: 3.57 GB G Free: 217.7 GB D: Free: 378.4 GB
VM Totsel: 4.00 GB C: Total 302.2 GB D: Totsl: 3896.3 GB

RAM Free: 780.6 MB
RAM Total 4.00 GB

SignPal Expert - [Untitled 1
Sjgna Expert - [Untitled 1] 1
@ Edit View Arrange Text Effects Bitmap Window Help
[ MNew Ctrl+ N
[ o L BESQ
1 p® Open.. Ctrl+O
1 7]
[— Close Ctrl+F4 L. (il EE N, -
k . I
51 §§ FindFile..
Save Ctrl+S
15 " Tools
Save As.. Ctrl+Shift+5
] 2 Import..
j& T Export..
‘: Files Flexiquote Reporis
Z Acquire Image 3 E
! E% Document Setup.., Ctrl+B L
Cs Resources 5
M ¥ cutlot. Carbel
o T CutContour.., g
| rint Setup.. Cirl+ Shift+P = i
3 Print. Ctri+P Printer Support License
Profiles
5 Archiveto Cloud .
— -8 @
Workspace 3 I 1 | ] L)
M 1Fiwe0z R CEENEEEEE T |
Chal 2 Fillloooi | |License expires in 14 days. Stroke [ Fill [ |
=S E
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i (= ™
Print Setup / M

— Printer
MName: “gpprinterZ24F 7738 FX DocuPrint g Properties. .. |
Status: Feady

Type: Microsoft enhanced Point and Print compatibility driver
Where:  4F 578
Comment:

—Paper — Crientation

Size; IM L‘ % Portrait

Source: | Automaticaly Select | " Landscape

Help | Network.. oK ; Canicel
o
.

4. Select File > Document Setup in SignPal and select paper size .

|53 sig pert - ]
File | Edit View Arrange Text Effects Bitmap Window Help
[ New Ctrl+N =N =
[ 9 1. o L & @
P8 Open.. Ctrl+-0
I 7 E7)
k Close Ctrl+F4 1 I L 1 L L I | L
H §f Find File...
Save Ctrl+S
52 " Tools
Save As., Ctrl+Shift+S
= B Import..
j} T} Eport.. g
E Files  Flexiquote Reports
Acquire Image 3 E
| B2 Document Sefup... Ctri+B l M
o Resources 5
‘ ¥  Cut/Plot. Ctrl+L
i I CutContour... g
] Print Setup... Ctrl=Shift+P = —
= Print.. Cte+ P Printer  Support  License
Profiles
% Archive to Cloud NI,
— - & @
Workspace 3 [ 1 | i)
4 1Fiuooz [T [T I _’12||
Spe 2 FillioooL | License expires in 14 days. Stroke [ Fill [N 2
— E =

GEE T —Hf*—‘:IE

E3 |em|
[E——] |
[E]2.268n ;
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[3] SignPal AASII Quick Start

1. Use the Rectangle Tool to create a rectangle.

L3 il Bt View Arrange Text Effects Bitmap Window Help [= =1y
DHERRSFILDA2ecnBRESAES
k- Q 1 | ! I;|) ! | ! "T ! | ! T ! | ! ? ! | ! ’T‘ Ea | ! IF ! | ! 1|2 ! Im‘:‘:‘;I
T Q) ;
% a
=SS e
)
D&
0|
) 7
i
" e e
RVRY sz | o )
_..__ |License expires in 14 days, - Y

2. Select Effect > Contour Cut. Then click ‘Apply’ in DesignCentral window.

| [3 File Edit View Arrange Text Effects Bitmap Window Help [~ =] x]
DEHBRRAFI LA onBESQA@ELS
k“ Q - | L ? L | L “T L | L ‘|‘- L | 1 ? 1 1 ? 1 1 1|0 L | L I 1|2 L Ium?;ci

. DesignCentral el
% . % 3 o
- E IContcur vi
O & |+ -
& 7] [0.500m : | |
& | 1 + [2000n = H
Q) Q "‘_ t [2.000n —I
[ ¥ Froportiona
‘D‘@h _ I::.'urm hc:lesl
o | B | MR
| N\
¥
-1615,  2748) |License expires in 14 days. i
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3. Apply the contour cut mark of GCC AASII by selecting Effect > Contour Cut Mark.

£21 SignPal Expert - [Uniitled 1] =aa 1
@ File Edit View Arrange Text [Effects| Bitmap Window Help ] _ = ][=] ]
DERBRAT, T |cnBERsQEe®
= == i | ine... I . — iy
ol o _t'!i_ . 0- Illﬂ_ Contour Cut... -|-I-|-?-|.I-|.1|c-|.l-|.A|L-|.|N|.=
! k‘ Q (= *=': Contour Cut Mark... %

rl‘ @g, 1 D Shadow... \
Sa‘ @ 4 [ Clear Contour Cut DesignCentral |l
|j Gla fa=d [ Separate Contour Cut I“']G 5 ]
ji‘ @ __' B Contour v]
2 @ ] =——=1|| 3
6 Q [ | | m]l}.ﬁ{:{in Eﬁ
] — + (20000
& B
e {‘? if-l—- [¥ Fropoitiorial
B_ 1 ™ With holes
) ; - Xy
Eo__- — I -
I 4 i 1} | - 3
4] T T O S ] o

Creates cut marks around contour cut objects [License expires in 14 days. !
— — ___ — — — — —

4. Select “GCC AASII” in SignPal DesignCentral window to create the AAS Il registration marks (4-

Point Positioning) and click ‘Apply’ in DesignCentral window.

|_ _| DesignCentral ]
i l

L _ 3

|+ One setforall

SignPal Instruction 19



GCC..

5. There are three types of GCC AASII registration marks: 4-Point Positioning, Segmental
Positioning, and Multiple Copies. To make ‘Segmental Positioning’ marks, please select “GCC

Segmentation” in DesignCentral window and then click ‘Apply’.

DesignCentral ]

4L
E
ar

6. For ‘Multiple Copies’, this function is not available in SignPal. Currently the ‘Multiple Copies’

function is only available under CorelDraw plug-in.

7. Select File > Print to print out the image.

."Sig"pz'.L.Dm-h_ﬂJ;ﬂL-J_1]—‘ﬂL-'—r——_—w- - J = |-E|
(G O New Ctrl+N lg o ——
-] |
= 3 Open.. Ctrl+0 =t i |x
D E Close Chi+F4  [F2. a0 I % EE @ Q ﬁ iy _/ﬁ\}

- - = - o - ey
"'k-"léﬁj':mdﬁle“' |-|.I-|.|-|.I-|.l|-|.l-|.|-|.lﬂc;1ﬂ.5
== Save Ctrl+5

i @ E Savess. Ctrl+Shift+S

S-‘b E B Import..

1|8 Egport., | I

jF‘ é Acquire Image »

Z @ EY Document Setup... Ctrl+B |E|

6 @F CutPlot. Cirl+L

B @ L_i Cut Contour..,

] | Print Setup... Ctrl+5hift+P |
O | <Y Print.. Cirl+P
||: <% Archive to Cloud
Waorkspace »

r : ™

SignPal Expert —

'la' Printer paper onientation dees not match decument. Adjust printer

L automatically?
Yes Mo /1

SignPal Instruction 20



GCC..

8. Set the Scale as 100% in Print page.

1~ Pritter- 0 Preview— 1 [
Mame: |\'\gpprinter2\4F_ﬁ§ﬁ_#\Fﬁ_FX DDCL_:_j Properties. .
Status: Feady
Type: Microsoft enhanced Point and Print compatibility driver
PostScript data; € Binary & ASCI
~ Copies- - Frint Options-
| Murmber of copies: 1 Eﬁ [ Selection only
Il y [T Border
| -2;3] uzi':J'J = Cal

= = £ L ollare I “Wireframe

' : Seal i ™ Substrate -
~ Scale : .
7 Fit drawing to paper ™ Guides
‘ " Fit border to paper [ Grd
[ Contour cut paths
[~ Template

=)=

I W Scale:

~ Tiling

[ Print tiled pages — Pasitian-
I Overlag: |0.000  —| JCenter |
Saianced : Offset 0000 — I
v Use device marginz Offszet v iD.DDDin 51
¥ lgnore overprint T :
' ™ |gnore bitmap transparency kK Cancel J
L— SSS —ly

9. Load the printout vinyl on the plotter and select File > Cut Contour to send data. You can preview
the job and change cutter’s parameter settings in ‘Properties’ tab of Cut Contour window. The

Production Manager will be automatic activated to complete the job.

1]

inge Text Effects Bitrmap Window Help

% % ? e x [ha L2 ﬂ (e Mo

E=
il

il e e PN e e e e

2 5
Select a Production Manager &J

| | O this computer [Local)

{7 On another computer [Mebwork)

" On the intermnet address:

I

| | Ok ﬂ Cancel

b = =
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\[[vaguar V61 LX@GCC USB 000
Properties... I g‘
EAEA

Job Status

— Material

|24.000x 1968 000n

& prooen =

=~ &
0 [isee 000 =

Send mode: |Send now

£

— Position

O« [15750n =

& [1.575n =
gl

~ Size

[ Fit to medis

1P [0.:000n -

—I Repeat Job

Send job |1 __IZ times

E Al colors

24 22 20

18

16

s

20 23 24 26 28 30 (32 34 38 38

18

18

12 12
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[4] How to set Die Cut

1. Open SignPal Expert

@ SigoPalExpen - 1
B rie e view

e Tert ffects Bamap Window Help

PP LY

9 @

25 T A T T e A I S e

(e

2. Use the “Text” tool or other drawing tools to create an image.

@ SignPal Expert - [Untitled 1]
[ File Edit View Arange Tedt Effects Bitmap Window Hel
9 P p

DARBRATI LA
L‘JT il 15

n

= B

Useful Tools

=

Helpful Resources

=

Mobile Apps
& ppstore

2012:2022 SA Intemational, Inc

Stroke [ Al W

o -

= -
]
LD
-
o

£

RBELLLHLYLLS PN

: = -
»lolal=|
1 [ioszmen =
% [0 =

y: [38578em =]
¥ Proportional

o s

i gu}

CEH]

& 7 le|

=
—
S —
B )

' Transforn _Clear

» X
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3. Select “Contour Cut” tool to create contours of the image.

@ SignPal Expert - [Untitled 1]
Bl File Edit View Amange Tect Effects Bitmap Window Help

PBHEBRETIADR 2 o[BG AHs

T P v 2 5 ? o 9 5
LB

o

s

3
i
|

|

|

=

E(Aw 7

ES
i

L
/

El
1

%

RELPLLIPLPPLL P

4. Select Fill/Stroke Editor and select Edit from dropdown menu.

Fill/Stroke Editor |3

5. Set Die Cut parameter in Customize Line Styles

Note : Dash: define the length of cutting line; Gap: define the interval between the dash lines

o~

Customize Line Styles

| 7

Dash Gap Dash Gap Dash Gap

[1em = Jo.200en=H [1m = Jo.200om=H [tm = |0.200am =

Add ‘ Update I Remove | Ok |

Cancel I

= [1.000cm

I~ With holes

(TR

K
& 2e|

= =
® 4
A3
[
WTrans!an
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6. Select Cut/plot icon to open the setting window

@ signpel Bxpert - [United 1]
Bl Fle Bt View Arange To Effects Btmap Window Hep

Ao oc/BEGQ e

< i . b Wi . i * T P Eid i)

L3

L3 \ =

B o] 2|

| C—

» S =
i[>}

7| =N

ale] & 7l

> S —

o x 4H

ali PN —

7. Select the model you are using from the dropdown menu, and click Edit... to open the Driver options

setting window.

I‘E‘ Cut/Plot - o
RX 151 CRELSE_Prnter_{ =l ok e =
e l Untitledjob Done e
. B Untitled_2.job Done Layout Preview
am?uv|% -

= 80 55 50 45 40 35 30 25 20 15 0 5 -
v Send all colors: e
&
Wesd ines o
I~ Weed border Panel margin; {0254cm 3 8 n
[~ Horzortal weed lines I~ Hosizontal splt fines &) =
I Vertical weed ines I™ Vertical spit Ires 2
- Al
T~ Essyweed 1™
Weedingmargin: [0258em =] I [
)
Driver aptions
2
Drawing Colors | Pass #1 | Pass #2_| Pause | i
F Ml CuCot. CuFat Sk ® A

)
3

[™ Use same driver options for all colors

[ Use samie driver options for all passes

25 20

Edit
¥ Advance after plat Addtional advance: [0.000cm —ﬂ

Total size: 25.84cm x 35.97cm Passes: |2 El? 1
Reset

.Nlm\ors ’TQ[@|Q‘ | Send Done ‘ |

15

10
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8. Set parameter in Before Jo

Note: Set Tool = 0 to perform cutting.

b tab.

Before Job || After Job || Macro |

Cut Fast i
[ Tool 0-8
M Speed 3
1 Force 5-61
M offset 0.01
[] Acceleration 0.7 = o 0.1-
|SPD:VS?2:FS12‘D:TDD.2?5: |
(o] [=o ]
[ Import... ] [ Export... ]

[ ok [ cancel | zopy

9. Enter avalue in Passes column to define the repeat times.

=] X
Job ] Status (o]
- Untitled job Done
Untitled_2.job Done
@ v|s
60 55 50 45 &0 36
¥ Send all colors: Single panel. single iob o
- Weed ines il
[~ Weed barder Panel margin: |0.254em 3: 8]
I Horzortal wead ines I Hosimril sl o &)
I Vedical weed inss I~ Vst sl s 2

T Essy weed "
Weedngmargn: [0254em =] [ Ao o = 2]
H
— Driver options — 1 1
T |
[DrawingColos [ Pasa#1 [ Pass#2 [Pawse | B
¥ I CuCont. Cut Fast  Skip ® ﬂ 2
3 g
-
e
1 3
5‘-
[ Use same driver options for all colors s
[T Use same driver options for all passes 1
Edt Gl
; &8
¥ Advance aiter plot Addtional advance: IOﬂODcm EC N
w
Totalsize:  25.84cm x 35.97cm Passes: |2 = i

Reset o |

al )

= v als|el =

10. The setting is complete.
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[5] How to set Creasing (RXIl model only)

1. Create a rectangle by Rectangle tool

@ SignPal Expert - [Untitled 1]
Bl File Edit View Arange Ted Effects Bitmap Window Help

DEERTa ¥ R == B é & 4
1) 5 10 15 25 30 35 40 45 50
s L i il z I z z I = I 1 L - S Gt a SR a 1 = 1
; / -
| B |m|
AT ~1 ¥

W Transfom _Cear

2. Use Bezier Path or Rectangle tool to create Creasing lines

;IJ .1 E'
& ] =
Q ], &/ i
B x

Qi

Q | =~

Qs 1 ¥ Tandom _Ceo

<

&

B

4=
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3. Select Cut/plot icon to open the setting window

@ SignPal Expert - [Untitled 1]
File Edit View Amange Text Effects Bitmap Window Help

ODER® Y. o 04 = 5 4

D N . ; - ; 7 Y i . I e =2
T \ =
% ] 2 Y |
‘—I A1 x| ¥
B Efeaioien =
= | ] B

e

il
I =
& m
& 1 & 7o
Q =[]
@ ®
A A =
a = _J
& - ¥ Transfomn _Clear
(€8
@

[Pyl
%

4. Select RXII-CR@USB_Printer_0 from the dropdown menu, and click Edit... to open the Driver options

setting window

¥ CutPlot u] x
[
[Fx 11-61CR@USB_Printer_{ ===t [ob Statue ~

- Untitled.job Done T — |

o Layout P v .
= I | Untitled_2,job Done L =l
5 ¥ |5 =

60 55 50 a5 40 35 30 25 20 15 40 5

¥ Send all colors:

Weed lines

I~ Weed border Panel margin: [0.254cm  —=| &)

Horizortal weed lines

I ™ Horizortal spit fines a1
I~ Vertical weed lines I Vestical spi fines

T~ Easyweed
Weeding margin: [0.2540m  —] r / gl
o
Driver options =
8
Drawing Colors | Pass #1 | Pass#2 | Pause | &l
FEERd  creasing  creasing @ ﬂ &
5 B CtCort. Cut Fast  Skip (] J E
7 E T S
g

[~ Use same driver options for all colars

25 30
L

[ Use same diver options for all passes
Edt...
¥ Advance after plot Addtional sdvance: [0.000cm  —=
Totalsize: 25 8dom x 35 37em Bissea [2 =
Reset i

15
L

0

=] Aicolers [ &= &) Send Dore |
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5. Set parameter in Before Job tab

Set Tool = 0 to perform Cutting

Set Tool =1 to perform Creasing

GCC RX I-61-CR X

[ Before Job | After Job || Macr |

Cut Fast ke

Tool 0 0-8
Speed 72 31!
Force [120 g 561
Offset [0.275 2| mm 0.01
[ Acceleration 0.7 =ic 0.1
‘SPD;VS?Z‘FSQD:TOE.Z?E‘ |

(o] (o]

[ Import... ] [ Export... ]

Apply

GCCRX II-61-CR >

(efors 4o | After b [ Macro|

| creasing ~ .
| &0l 1 ) 0-8 ”
Speed |15 =1 cmfs 31!
Force Idl]l] : q 5-6I
Offset 0.000 3| mm 0.01
[ Acceleration 0.7 e L 0.1

|SP1:\1’S15:FSM}B:TOB 000, ‘

(o]

[ Export... ]

l Delete ]

l Import... ]

Apply

6. Enter avaluein “Passes” column to define a number of times for cutting/creasing.

F Cut/Plot m} e
[RX I 551-CR@USB_Printer_0 ~| ﬁ Job Status A
Properties Untitled.job Deone m
— QJ Untitled_2.job Done e A
amb?9vlsl :
B0 55 50 45 40 35 30 25 20 15 10 &
I¥ Send all colors iSlngIe panel, single job lj i f . - - ! - : - - . * -
Weed lines - ]
[~ Weed border Panel margin: 10.25‘961“ 5: Gl
&
™ Horizortal weed lines [~ Horizontal spit lines e |
I Vertical weed lines [~ Vertical spit lines g_
: 2
[T Easyweed B
Weeding margin m ™ Around grougs and best 2]
8
1~ Driver options
T |
Drawing Colors ] Pass #1 Pass #2 | Pass #3 I Pause S_
7 EMlRed cessng SEEirlleressin el 2 2
‘7 B CutCort..Cut Fast  Skip Cut Fa ® 3 q
7 Il ack  Skip Skip Skip @& 2
3, pasect e
: > : T
o) I i i
[~ Use same driver options for all colors = 1 i
&
[~ Use same driver options for all passes | 7 !\_-.._JI(:
Edt.. || B |
|
| l g |
[V Advance after plat Addttional advance: ]D.DDDcm 3: 1 A ,),'!
o iy {
Total size: 25 84em x 35.97cm Passes: ]E} 5-3: = \\‘
|
Reset & i
0 \}._J,f F S
S rl
B e S a2 o
] b
IE All colors L3 G)\I =] J QJ Send Done
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7. User can decide whether to perform cut/crease each pass. By right clicking on drawing color, user

can define which action to be taken for each pass.
For example, if user want to do creasing in the first pass and no need to do creasing in the second and

third pass, user can right-click and select “Skip this pass” to skip the process.

Drniver options - 1~ Driver options —

[ Drawing Colors ] Pass#1 | Pass #2 | Pass#3 ] Pause
A [ ceasing -
S B CutCont. . Cut Fast Sk Cutbast

Drawing Colors | Pass#1 | Pass#2 | Pass#3 | Pau

7 ElRed  ceosng  SRTPHeesng

B CuCont .Cut Fast Skip Cut Fast

o

B

e s Skip Skip bl R Skip Cut Medium
Cut Slow
< > F creasing
I™ Use same driver options for all colors I™ Use same driver options for all colors | Skip this pass
[~ Use same driver options for all passes I~ Use same diiver options for all passes [
Edit... Edit...
[V Advance after plot Additional advance: |0.000cm = ¥ Advance after plot Additional advance: [0.000cm 32
Total size: 25.84cm x 35.97cm Passes: (€ 3: Total size: 25.84cm x 35.97cm Passes: |3 Ej;

Reset Reset

8. The setting is complete.
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[6] SignPal Features List

Text

Text Tool

Arc Text

Path Text
Vertical Text
Vertical Path Text
Kerning

Break Apart/ Join

Drawing
Bezier

Freehand Drawing

Shapes

Rectangle

Oval

Registration Mark Tool
Measure Tool

Path Editing

Select Point Tool
Remove Point

Add Point

Straighten Path

Round Corner
Sharpen Corner
Optimize by Curve
Optimize by Smooth Arc
Optimize by 3point Arc
Make Arc

Reduce Points

Close Path

Change Start Point
Cleaver

Scissors

Expert

Apprentice
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Make Right Angle
Break Path

Join Paths

Align Horizontal

Align Vertical

Align Points

Apply Length and Angle
Remove Tiny Objects
Vector Eraser

Cleaver by Path

Working with Files
Job Info

Scanning

Achieve to Cloud

Workspaces

View
DesignCentral
Color Mixer

Snap

Arrange

Group

Compound

Mask

Guides

Contour Cut
Convert to Outlines
Convert Stroke to
Outlines

Convert Linked to Native
Path Direction
Order

Cut Order

Align

Spacing

Rotate
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Resize

Deskew

Mirror

Step and Repeat

Effects

Combine

Outline

Contour Cut
Contour Cut Mark
Shadow

Bitmap
Autotrace
Color Mode

Production
Cut/Plot

Manual Split Lines
Tile All Copies
Panel to Border
Auto-weld
Auto-trap
Overcut

Optimize Cutting Order
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